McTrans
M ov i n g Te ch n o l o g y

™

Volume 32 January 2005 Newsletter

HCS+

5th Highway Capacity Symposium in Yokohama

McTrans has spent the last four
years developing new features for the
Highway Capacity Software toward
this release of HCS+. This new version
adds many signiﬁcant improvements
for more efﬁcient data coding, more
comprehensive analyses, and better
output options. Existing computational
modules have been signiﬁcantly
improved to offer automated multipleperiod analysis, preset phasing and
I-value computation in Signals, and a
compeletely new HCS-type module
for Freeway Facilities. And, there are
additional programs to perform signal
warrant analyses, turning movement data
collection, and separate planning analysis
methods. Finally, the new continuous support
mechanism covers all technical assistance and
provides free future upgrades for ofﬁce or
agency licenses, as well as single CPU licenses,
which now are available.

The 5th International Symposium on Highway Capacity and Quality
of Service (5th ISHC) will be held in Yokohama, Japan from July 25 to
29, 2006. The conference is sponsored by the Transportation Research
Board (TRB) and the TRB Committee on Highway Capacity and Quality of
Service (AHB40). Papers on research or on practical issues related to any
aspect of highway and transport capacity and quality of service are being

Modules
Five new modules have been added to this new
release: one to overhaul an existing computational
program; three to supplement capacity analysis
from the planning perspective; and one as a very
useful tool for trafﬁc engineering analysis.

solicited now.

continued on page 2

Further information on the conference and abstract submission is
available via the Committee AHB40 website: http://www.a3a10.gati.
org/ or by e-mail to 5thISHC@civil.nagoya-u.ac.jp. Abstracts are due
no later March 31, 2005. All abstracts, papers and presentations must
be in English. Papers will be peer reviewed and made available in the
proceedings to all delegates.
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HCS+ Features continued
Freeway Facilities: A complete overhaul of this module replaces
the research-level spreadsheet with an HCS-style interface. With
much assistance from the authors of the spreadsheet, Nagui Raphail
of North Carolina State University and Brian Eads of Crawford,
Murphy & Tilly, Inc., this new module automates the procedures in
HCM 2000 Chapter 22 in easy-to-use coding and reporting similar
to other HCS modules. This analysis provides the user with the
ability to analyze many freeway segments, including basic freeway
segments, ramps and weaving areas, over multiple time periods with
oversaturated condition capabilties.

additional capabilities: ARTPLAN adds a multi-modal planning
analysis to include bicycle, pedestrian and transit effects on arterials;
FREEPLAN offers a planning-level analysis of up to 20 freeway
semgents (basic, interchange and toll); and HIGHPLAN develops
service volume tables including maximum v/c and AADT for LOS
categories on two-lane facilities.
Signals
Several new features have been added to the Signals module to
greatly improve the data coding and overall analysis efﬁciency of this
most-widely used module.
Muliple-Period Analysis: This

feature allows coding of multiple time
periods, especially for oversaturated ﬂow analysis, implementing
the methodology prescribed in HCM 2000, Chapter 16, Appendix
F. The automated application passes the residual queue from one
period to the initial queue for the subsequent period. The summary
report shows building and dissipating of queuing over entire analysis.
Preset Phasing:

Warrants: This

new module automates the procedures in the 2003
Manual on Uniform Trafﬁc Control Devices (MUTCD) for the
eight prescribed signal warrants. All data required for performing
these tests and checks are accommodated in the HCS-style interface.
A complete summary report listing the results for each warrant
and sub-warrant, as well as a volume-speciﬁc report for details on
warrants 1, 2 and 3, are provided.

The most
likely phasing options are
presented in a pull-down
list based on coded lane
conﬁguration. Options
for pretimed, actuated or
semi-actuated operations are
available as well as selecting
protected or permitted leftturn phases. All movements
are automatically entered for
the phase option selected,
with normal speciﬁcmovement coding still
available.
I-Value:

The ability to import
upstream signal data to get
the volume-to-capacity ratios
for determing the I-Value
for each approach has been
added. The volume-weighted
average of the contributing
movement is used to select
the appropriate I-Value from
HCM 2000 Exhibit 15-7.
Quick Entry:

LOSPLAN: Three

programs from the Florida Department of
Transportation, courtesy Doug McLeod, have been added for
planning level analysis of Arterials, Freeways and Two-Lane Roads.
These programs expand on the HCM 2000 methods to include

This feature
from HCS2000 has been
updated to make coding lane
conﬁguration even more
efﬁcient. The arrows now
exist for all approaches on a
re-designed screen for easier
selection.
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Advice: A new feature in this release is the “Advice” button to

monitor data coding relationships for potential errors or oversights.
This button becomes available when data combinations exist
that raise particular questions for the user. Several data ﬁelds are
monitored for potentially conﬂicting situations, such as coding a
Duration of 1.0 with Peak-Hour Factors less than 1.0.
Data
Much improved and substantially expanded reporting capabilities, as
well as two data collection tools, are part of this major upgrade.
Reports:

Several new formatted reports, now encompassing virtually
all worksheets in the HCM 2000. Each formatted report can now
be saved for easy forwarding or sharing with others. Graphing
sensitivity analyses is introduced with control and total delay charted
in HCS-Signals and more graphs coming in future updates.
Collection:

A program
(DAITA) from Dr. Scott
Washburn of the University
of Florida, has been added to
allow collecting intersection
turning movement counts
directly from within HCS+.
This program uses laptop
keys to increment the volume
for each movement at an
intersection, storing the data
for use in HCS+ modules.
The Signals and Warrants
modules will also now read data from Jamar count boards.
Licensing
Expanded license options now offer single CPU licenses in addition
to ofﬁce licenses. All licenses include the ﬁrst year of toll-free
technical support and electronic maintenance, providing all upgrades
automatically with no more upgrade fees. The introductory price
list is shown below:
Single CPU
Single Ofﬁce2

New
$500
$1000

Upgrade from HCS2000
$250
$500

Annual Support1
$100
$200

First year of support is included with the license fee.
Agency License (see page 22) upgrades are available onw a pro-rated
schedule.
1
2

Note of Thanks: This major work could not have been accomplished

without the expertise and guidance of Phil Hill and David Hale, both of
the McTrans Center. Mr. Hill provided constant programming supervision
and design skills and Dr. Hale was invaluable in his insights of traffic
engineering applications by users. Of course, many others contributed
greatly to the final implementation of this significant upgrade, including
the McTrans programming staff (Jim Fliess, Charles Porter), student
assistants (Rohini Bobba, Jigar Shah, Jose Thota), the McTrans accounting
and processing staff (Jonathan Czerenda, Lee Duda, Debbie Escalera, Mitch
Davis), and a long list of dedicated beta testers and users. ~Bill Sampson

NEW Products
DYNASMART-P
The Federal Highway Administration (FHWA) has released
DYNASMART-P, a state-of-the-art dynamic network trafﬁc
operational planning tool, developed and supported by the
University of Maryland under the FHWA’s Dynamic Trafﬁc
Assignment (DTA) research project. DYNASMART-P (DYnamic
Network Assignment-Simulation Model for Advanced Road
Telematics) supports transportation network planning and trafﬁc
operations decisions, including evaluation of ITS deployment
options, through the use of simulation-based dynamic
trafﬁc assignment. This tool combines (1) dynamic network
assignment models, used primarily in conjunction with demand
forecasting procedures for planning applications, and (2) trafﬁc
simulation models, used primarily for trafﬁc operational studies.
DYNASMART-P provides the capability to model the evolution
of trafﬁc ﬂows in a trafﬁc network, which result from the decisions
of individual travelers seeking the best paths en-route over a given
planning horizon. For more details, please see the Summer 2004
newsletter.
DYNASMART-P operates on Windows XP, Windows 2000,
Windows ME or Windows NT 4.0 (service pack 5) or higher. A
minimum of 300 MB of the hard drive space and the minimum of
512 MB of RAM memory are needed to run the model, depending
the size of the network and analysis time period. Execution times
vary with the hardware used and size of network, though typical
experience on high end PC’s suggests approximately a ratio of
simulation to actual time of 1 to 0.10 ~ 0.25 on actual networks.
The FHWA has also developed an input editor, DSPEd, to assist
users in preparing input data. DYNASMART-P and DSPEd are
available at LOS 1 for $1750 (#DYNA) for fully supported and
$1000 (#DYNA.UN) for licenses with limited technical support.
Turning Templates Plastic & CAD V 3.0
New for 2005, Transoft Solutions introduces Turning Templates
Plastic & CAD V3.0. We have combined our popular Plastic
Templates with the latest release of our newest release: CAD Turning
Templates V. 3.0
Turning Templates CAD V3.0 allow designers to evaluate turns
for a number of standard vehicles at angles of 30, 60, 90, 120, 150
and 180 Degrees. They may be rotated, moved, scaled, mirrored
and saved within a drawing ﬁle to assess most turning scenarios
with ease. Turning Templates 3.0 features our “Turn Wheels from
Stop” templates. With these new templates, it is even easier to assess
turn maneuvers when space is limited. CAD Turning Templates 3.0
work with virtually any CAD program capable of reading .cel or
.dwg ﬁle formats including AutoCAD, MicroStation, AutoCAD LT,
Imagineer, InteliCAD and CADDIE.
Bundled with the CAD Templates are Transoft’s Plastic Turning
Templates for AASHTO 2001 vehicles. At 1/40 scale, they include
all the standard AASHTO 2001 vehicles including WB-40, WB-62
and WB-67. Made of durable high-density polycarbonate, these
templates are the perfect addition to every Transportation Engineer’s
toolkit for presentations and during the project approval process
Turning Templates Plastic & CAD V 3.0 (#TTC) is available at
LOS 6 for $650.

3
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NEW Products

Update

PRENOSTOP/TEAPAC
PRENOSTOP/TEAPAC is a new program from Strong Concepts
which prepares and runs NOSTOP input ﬁles, using the standard
TEAPAC graphical dialogs and trafﬁc engineering terms for each
signal such as those found in SIGNAL2000/TEAPAC. All the
information that is needed by NOSTOP for each intersection is coded
automatically. Level 1 (#TPCPNS.1) handles up to 12 intersections
and costs $195 for a site license. Level 2 (#TPCPNS.2) handles up to
100 intersections and offers a Subsystem feature for $295.
If the individual operation of each signal in the arterial or network
is designed with SIGNAL2000, and coordinated timings are designed
with other programs in the TEAPAC system, then PRENOSTOP
can use these data ﬁles directly so NOSTOP results can be generated
without any additional data input. If the offsets (or cycle length) are
changed by the NOSTOP optimization, the changed timings can be
imported back into PRENOSTOP for direct transfer to programs for
simulation of the modiﬁed timings. This allows NOSTOP to be used
in a seamlessly-integrated fashion for both evaluation of optimized
timings and optimization of offsets and cycle.
PRENOSTOP includes the unique TEAPAC Visual Mode which
provides an intuitive, graphical user interface as a true Windows
program. The Visual Mode also provides a complete and fullyindexed on-screen user guide and context-sensitive help and error
diagnostics. Other powerful input methods include the Tabular
View and the Manual Mode.

SITE/TEAPAC
TEAPAC2004 version of SITE/TEAPAC (#TPCSIT) has been
released by Strong Concepts as Ver 4.60. This major upgrade uses
the standard TEAPAC2004 input dialogs, or data ﬁles from other
integrated TEAPAC programs, and calculates projected trafﬁc volumes
which result from the deﬁned development scenario. Multi-use and
multi-site scenarios are handled easily, and new volume adjustment
inputs allow factoring volumes on a movement-by-movement basis.
Also, new sensitivity controls for global testing of factored volumes
have been added. The data ﬁles for SITE have also been updated to
be completely compatible with SIGNAL2000/TEAPAC (#TPCS2K)
so complete multi-intersection systems with up to 500 intersections
can be seamlessly integrated with SIGNAL2000 analyses, allowing
complete HCM-based capacity analysis and timing optimization to be
performed in conjunction with the SITE projected volumes.
SITE has been updated with a major enhancement for managing
the list of nodes in the complete system being studied, and
intersection selection has been enhanced with a new drop-downlist selection option. The complete network can also be visualized
in a graphical network view diagram which can be enhanced with
the addition of a bitmap background. A major enhancement to
the output window for display of results and data input summaries
now permits a virtually unlimited amount of output to be displayed,
with many enhancmenets such as a sizeable, moveable, appendable
window, toolbar buttons, etc.
SITE Level 1 (#TPCSIT.1) handles up to 12 intersections and
costs $395 for a site license. Level 2 (#TPCSIT.2) handles up to 100
intersections and offers a Subsystem feature for $495.

Update

Update

TEAPAC2004 Version 6
TEAPAC2004 (Version 6) has been released by Strong Concepts
with a major enhancement to the generic user interface used by all
TEAPAC programs, as well as major developments to individual
programs. The most apparent change is the new completely seamless,
one-click, one-ﬁle exchange of all input and results between all
programs, including network connections, intersection geometry
and conditions, and trafﬁc volumes; as well as calculations of HCM
satﬂows, optimized timings, peak-period turn counts and estimated
site trafﬁc. Other enhancements include new volume adjustment
inputs to allow factoring volumes and adding additional volumes
on a movement-by-movement basis, new sensitivity controls for
global testing of factored volumes, additive volumes, factored
satﬂows, minimums, clearances, etc., as well as the complete
implementation of the enhanced TEAPAC2004 (Ver 6) user
interface. The TEAPAC programs updated with the TEAPAC2004
(Version 6) interface include SIGNAL2000 (#TPCS2K), NOSTOP
(#TPCNST), PRETSPPD (#TPCPTS), PREPASSR (#TPCPPS),
PRETRANSYT (#TPCPTR), PRENETSIM (#TPCPNT),
PRESYNCHRO (#TPCPSY), SITE (#TPCSIT), WARRANTS
(#TPCWAR), TURNS (#TPCTRN), TED (#TPCTED) and
TUTOR (#TPCTUT). A new program, PRENOSTOP, has been
added, and additional major enhancements have been made to SITE,
WARRANTS and TURNS, as described in separate articles.
TEAPAC2004 is available as a new license from McTrans and Strong
Concepts in several options -- the TEAPAC Trafﬁc Engineering
Package (#TPC*.*.1), the TEAPAC Signal Timing Analysis Package
(#TPC*.*.2) and the TEAPAC Site Impact Analysis Package
(#TPC*.*.3).

WARRANTS/TEAPAC and TURNS/TEAPAC
After 2 years in development, the TEAPAC2004 versions of
WARRANTS/TEAPAC (#TPCWAR) and TURNS/TEAPAC
(#TPCTRN) have been released by Strong Concepts as Ver 3.60 and Ver
2.60, respectively. These major upgrades use the standard TEAPAC2004
input dialogs, or data ﬁles from other integrated TEAPAC programs,
performing MUTCD 2003 signalized and stop sign warrant analyses,
count tabulations and peak-period analysis. New volume adjustment
inputs allow factoring counts on a movement-by-movement basis. New
sensitivity controls for global testing of factored data have been added.
The data ﬁles for Warrants and Turns have also been updated to be
completely compatible with SIGNAL2000/TEAPAC.
WARRANTS and TURNS have been updated with a major
enhancement for managing as many as 500 intersections of count data
in a single data ﬁle and analysis. The complete network can also be
visualized in a graphical network view diagram which can be enhanced
with the addition of a bitmap background. A major enhancement to
the output window for display of results and data input summaries now
permits a virtually unlimited amount of output to be displayed, with
many enhancmenets such as a sizeable, moveable, appendable window,
toolbar buttons, etc.
Level 1 versions (#TPCWAR.1 and #TPCTRN.1) handle up to 12
intersections and cost $395 and $295, respectively, for a site license.
Level 2 versions (#TPCWAR.2 and #TPCTRN.2) add the functionality
of the other program for $595 (ie, TPCWAR.2 performs the peak-period
analysis of TPCTRN.1, and TPCTRN.2 performs the warrant analyses
of TPCWAR.1). Level 3 versions (#TPCWAR.3 and #TPCTRN.3)
handle up to 100 intersections and offer a Subsystem feature for $695.

Update
VISSIM 4.0 and VISUM 9.1
PTV America, Inc. is proud to
announce the release of VISUM
9.1 to its North American
customers.
VISSIM 4.0 – Microscopic
Simulation

PTV America, Inc. is proud to
announce the release of VISSIM
4.0 to its North American
customers. One of the most
exciting features of the new
VISSIM 4.0 is that it now offers
COM programming capability.
VISSIM empowers trafﬁc and
transit professionals to efﬁciently
and cost effectively model multimodal corridors, freeways, toll
plazas, ITS, HOV and HOT
lanes, downtown grid networks,
bus rapid transit centers,
arterial streets, roundabouts,
access management, bicycles,
pedestrians and much more.
VISUM 9.1 – Travel Demand
Modeling

Modelers in more than 50
countries rely on VISUM
to meet their travel demand
modeling needs. One of the key
features of the recent upgrade
is that VISUM 9.1 offers
integrated LOS computation
powered by TRAFFIX™.
VISUM 9.1 is GIS integrated
and offers multi-modal
assignment; the ability to
store paths during assignment
for select link and other ﬂow
analyses; traditional and activitybased trip distribution and mode
choice, transit service planning
and schedule-based ridership
prediction, as well as dynamic
highway and transit assignment.
VISUM is fully integrated with
VISSIM.
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HSA Software

HCS:

When printing Formatted
Reports, margins should
be set to 0.25” in the “File
> Page Setup” screen of
Internet Explorer to ensure
single-page reports fit
on one page. It may be
necessary on this same
Internet Explorer screen,
to suppress the automatic
header and/or footer
by simply blanking the
appropriate field(s). Also,
make sure the setting in
“Tools > Internet Options >
Advanced > Printing” is set
to “Print background colors
and images” for graphics in
these reports to be properly
displayed and printed.
Please note that users must
have version 5.01 or higher
(version 5.5SP1 or higher
preferred) of the Internet
Explorer for these Formatted
Reports to work properly.

CORSIM:

5

Did You Know?

Curvature, elevation and
friction coefficient are only
used to determine a safe
upper limit to the free-flow
speed on a freeway link.
If that safe speed is less
than the input link free-flow
speed, the safe speed will be
used instead, which would
affect travel speed. If the
input speed is less than the
safe speed, curvature will
have no effect. CORSIM will
issue a warning if it reduces
the link free-flow speed
because it would exceed the
safe speed. The calculation
of safe speed is described
in the CORSIM Reference
Manual.

TRANSYT-7F:

The Original Cycle Length
(OCL) affects the first
individual in the first
generation of genetic
algorithm optimization. The
first individual contributes
to the optimization process,
and is also used to create
“Initial” results for the
output file. Typically the
first individual in the first
generation of optimization
simply reflects the usercoded initial timing plan.
However, if the initial timing
flag is turned on, coordinated
nodes on the optimization
node list immediately adopt
the OCL. All other individuals
in the first generation are
unaffected by the OCL.
Subsequent individuals in
subsequent generations
aren’t explicitly affected by
the OCL. However, they are
usually implicitly affected by
gene pool contributions from
the first individual

Package

Version

Status

Target

Distribution

HCS+™
TRANSYT-7F
TSIS
IDAS
TNM
Turbo Architecture

5.1
10.2
5.1
2.3
2.5
3.0

Testing
Complete
Complete
Complete
Complete
Complete

January
Available
Available
Available
Available
Available

Registered users may upgrade
Patch download
Sent to Registered users
Sent to Registered users
Sent to Registered Users
Registered users may upgrade
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US Postage
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Calendar
NEED Training?
• Highway Capacity Analysis
(HCS+)
• TRANSYT-7F Release 10
• CORSIM (TSIS 5.1) for
Beginners
• Site Impact Analysis
• MUTCD
Contact McTrans to set up a
training course in your area, or
read about currently scheduled
training courses at:
http://mctrans.ce.ufl.edu/
training/

Training
VISSIM Basic Course
VISSIM Advanced I - Signalized Control
VISSIM Advanced II - Specialized Applications
PTV America (541) 754-6836

Feb 1-2, 2005
Feb 3, 2005
Feb 4, 2005

“Designing Optimized Traffic Signals and Systems
Using TEAPAC, PASSER, TRANSYT and CORSIM”
University of Central Florida (407) 882-0260

Feb 9-11, 2005

Signal Capacity Analysis Seminar
McTrans 1-800- 226-1013 ext. 229

Mar 1, 2005
Mar 3, 2005

“Microcomputer Applications in Signal Timing
Using TEAPAC, PASSER, TRANSYT and CORSIM”
Northwestern University (800) 323-4011

Apr 18-21, 2005

Highway Capacity Analysis Seminar
McTrans 1-800-226-1013 ext. 229

TBA

TBA

Traffic Network Study (TRANSYT-7F) Seminar
McTrans 1-800- 226-1013 ext. 229

TBA

TBA

CORSIM Simulation for Beginners
McTrans 1-800-226-1013 ext. 229

TBA

TBA

San Diego, CA

Orlando, FL

Raleigh, NC
Lexington, KY
Evanston, IL

Conferences
TRB Annual Meeting
TRB (202) 334-3472

Moving Technology

Jan 9-14, 2005

Washington, DC

http://mctrans.ce.uﬂ.edu/training/ for up-to-date training information

